
Research, Society and Development, v. 9, n. 11, e1459119586, 2020 

(CC BY 4.0) | ISSN 2525-3409 | DOI: http://dx.doi.org/10.33448/rsd-v9i11.9586 

1 

Techniques using ImageJ for histomorphometric studies 

Técnicas de uso do ImageJ para estudos histomorfométricos 

Uso de técnicas en ImageJ para estudios histomorfometricos 

 

Received: 10/23/2020 | Reviewed: 10/29/2020 | Accept: 11/04/2020 | Published: 11/11/2020 

 

Lucimar Rodrigues Vieira Curvo 

ORCID: https://orcid.org/0000-0003-1583-9709 

Instituto Federal de Educação, Ciência e Tecnologia de Mato Grosso, Brasil 

Universidade Católica Dom Bosco, Brasil 

E-mail: lucimar.curvo@cba.ifmt.edu.br 

Milena Wolff Ferreira 

ORCID: https://orcid.org/ 0000-0001-9763-2239 

Universidade Católica Dom Bosco, Brasil 

E-mail: rf7649@ucdb.br 

Celso Soares Costa  

ORCID: https://orcid.org/0000-0001-7040-7058 

Instituto federal de Educação, Ciência e Tecnologia de Mato Grosso do Sul  

E-mail: celso.costa@ifms.edu.br 

Guilherme Ribeiro Capibaribe Barbosa 

ORCID: https://orcid.org/0000-0003-2252-5054 

Universidade Católica Dom Bosco, Brasil 

E-mail: guilhermeribeiro15900@gmail.com  

Sandra Adriana Uhry 

ORCID: https://orcid.org/0000-0001-8604-9849 

Universidade Católica Dom Bosco, Brasil 

E-mail: sandra@gervasiooliveira.adv.br 

Ulisses Simon da Silveira 

 ORCID: https://orcid.org/0000-0001-9416-0571 

Universidade do Estado de Mato Grosso do Sul, Brasil 

E-mail: ulissessimon@hotmail.com  

 

 

 



Research, Society and Development, v. 9, n. 11, e1459119586, 2020 

(CC BY 4.0) | ISSN 2525-3409 | DOI: http://dx.doi.org/10.33448/rsd-v9i11.9586 

2 

Alanderson Rodrigues da Silva 

ORCID: https://orcid.org/0000-0001-5560-1098 

Universidade Católica Dom Bosco, Brasil 

E-mail: alander_rodrigue@hotmail.com 

Gisele Braziliano de Andrade 

ORCID: https://orcid.org/ 0000-0001-6289-9945 

Universidade Católica Dom Bosco, Brasil 

E-mail: gisele@ucdb.br 

 

Abstract 

Computational histomorphometry is an available and easy tool that has been used in the 

assessment of morphophysiological tissue changes, offering greater scientific reliability to the 

data, as well as facilitating the automation process. The present work aimed to describe the 

application of the methodology of the free software ImageJ for morphological evaluation of 

fish tissues. For this, micrographs of histological sections of the intestinal tract of fish stained 

with Periodic Acid-Schiff (PAS) were used as a model. The images were analyzed for 

variables of length, width, and tissue area and, number of cells or molecules. The application 

of computational histomorphometry demonstrated efficiency in the evaluation of histological 

structures of the intestine of fish supplemented with probiotics, contributing to the 

improvement of image analysis techniques in animal tissue models. 

Keywords: Histology; Morphology; Tissues; Software imageJ. 

 

Resumo 

A histomorfometria computacional é uma ferramenta disponível e de fácil utilização, que tem 

sido utilizada na avaliação de alterações morfofisiológicas dos tecidos, oferecendo maior 

confiabilidade científica aos dados, além de facilitar o processo de automação. O presente 

trabalho teve como objetivo descrever a aplicação da metodologia do software livre ImageJ 

para avaliação morfológica de tecidos de peixes. Para isso, utilizou-se fotomicrografias de 

cortes histológicos do trato intestinal de peixes corados com Periodic Acid-Schiff (PAS) 

foram utilizadas como modelo. As imagens foram analisadas quanto às variáveis de 

comprimento, largura e área do tecido e número de células ou moléculas. A aplicação da 

histomorfometria computacional demonstrou eficiência na avaliação das estruturas 

histológicas do intestino de peixes, contribuindo para o aprimoramento das técnicas de análise 

de imagens em modelos de tecidos animais. 
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Palavras-chave: Histologia; Morfologia; Tecidos; Software imageJ. 

 

Resumen 

La histomorfometría computacional es una herramienta disponible y fácil que se ha utilizado 

en la evaluación de cambios morfofisiológicos tisulares, ofreciendo mayor confiabilidad 

científica a los datos, además de facilitar el proceso de automatización. El presente trabajo 

tenido como objetivo describir la aplicación de la metodología de uso del software libre 

ImageJ en la evaluación morfológicos en tejidos de peces. Para ello, se utilizaron como 

modelo micrografías de cortes histológicos del tracto intestinal de peces teñidos con Ácido 

Periódico-Schiff (PAS). Las imágenes se analizaron en busca de variables de longitud, ancho 

y área de tejido y número de células o moléculas. La aplicación de histomorfometría 

computacional demostró eficiencia en la evaluación de estructuras histológicas del intestino 

de peces, contribuyendo a la mejora de las técnicas de análisis de imagen en modelos de 

tejidos animales. 

Palabras clave: Histología; Morfología; Tejidos; Software imageJ. 

 

1. Introduction  

 

The approach of the histological structures of the gastrointestinal tract of fish allows 

application of this knowledge in the understanding of animal biology, morphophisiology, 

ethology and pathology, helping the development of food production chains, contributing to 

the rational use and with greater sustainability of environmental services (Tawfiek et al, 

2017). Likewise, knowledge of the morphology of the digestive system in various species of 

fish is useful for research on food management and preparation of appropriate diets for 

adaptation and well-being in captivity (Rotta 2003; Moawad, Tawfiek & Awaad 2017; Vidal 

et al, 2019). The technology associated with microscopy has advanced on the world stage, 

enabling biological studies of images which provide the analysis of quali-quantitative data 

increasingly accessible, faster and more accurate (Schindelin, Rueden, Hiner & Eliceiri 2015).  

The use of digital images as a scientific tool has collaborated with life scientists and 

through the application of image processing techniques to analyze data (Schindelin et al, 

2015). The Digital Image Processing (PDI) of histomicrographs can be defined as 

computational technique or method that has as a premise the performance of several 

operations on the captured image, to improve it and obtain useful data (Carson & Hladik 

2009; Gonzalez & Woods 2010; Guo & Zhang 2019). 
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According to Sengar, Dutta & Sarkar (2017) there are several steps for making and 

manipulating images, including acquisition, pre-processing, processing, analysis, and data 

extraction. The use of the PDI for a histomorphometric analysis consists, initially, in the 

capture of the image to be evaluated by a device (sensor), which can be a high-resolution 

digital camera, attached to the composite optical microscope (Schnell et al, 2020; Silva et al, 

2016), that permits the picture to enlarge more than 2000 X (Novaes et al, 2007; Dias 2008; 

Novaes et al, 2010; Wang, Ka & Chen 2014). 

The histomicrographs obtained by the sensors, in general, must go through pre-

processing which allows the correction of geometric distortions and promotes the filtering of 

noise coming from the camera, performing transformations and improvements (Burger & 

Burge 2008; Hannickel et al, 2012; Casero et al, 2017; Passos et al, 2020).  

In this work, we sought to focus on the ImageJ software as a study of how open source 

software promotes a tool interface, demonstrating an abundance of methods and approaches 

for analyzing digital images that can be easily accessible to scientific community (Schindelin 

et al, 2015; Caicedo et al, 2017).  Therefore, the objective of this work was to demonstrate the 

use of the ImageJ Software for histomorphometric studies promoting accurate and automated 

measurements.  

 

2. Computational Tool for Histomorphometric Evaluation 

 

There are many technical and technological advances in the computational area that 

help all areas of knowledge (Passoni et al, 2014), emphasizing that the use and applicability 

of software and technologies can bring benefits to science, economics and society (Santos & 

Kalid, 2020). Through advances in hardware, software, and applications, several possibilities 

for using digital image processing have been created (Russ 2015). A tool that has been used in 

image analysis is morphometry, which is a word originated from the Greek for ‘measures a 

shape’, employed to methodically measure structures based on morphology and patterns of 

morphometry (Søreide et al, 2009) is an interactive tool that allows obtaining variables that 

can be confirmed by statistics (Di Leva, Bruner & Widhalm 2012). In this same 

understanding, Mojekwu & Anumudu (2015) complement that “the morphometry can be 

defined as a set of procedures to analyze a variability in the size and shape of organs and 

organizations.” 

The application of these technological innovations has been reported in several areas of 

science, but mainly human medicine (Oliveira, Oliveira & Pinheiro 2010; Sousa, Vasconcelos 
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& Soares 2012; Rodrigues et al, 2013; Eberhardt et al, 2016; Jeffcoate, Musgrove & Lincoln, 

2017; De Laffitte Alves et al, 2018; Weber & Santos 2019) and veterinary (Ginel et al, 2002; 

Egan, Brennan & Pignolo 2012), agronomy, zootechnics and biological sciences (Passos et al, 

2020; Karachle & Stergiou 2010; Zur & Klement 2015; Meurer et al, 2007; Valente et al, 

2017; Grune et al, 2018) and hematology (Jatobá et al, 2018). In addition to these, there are 

reports in the literature of material engineering (Hannickel et al, 2012), soil sciences (Passoni 

et al, 2014) and immunology. 

In the medical and biological sciences, there are many possibilities for using ImageJ: (i) 

in the evaluation of normal or altered anatomical structures of organisms, among them: Atotal 

= total area of intestinal villi, A = height (distance: apex/muscular layer), ATotal = Total 

height (Apex to terminal portion of tunic serosa), LA, M, B = width (Apical, Average and 

Basal), EE = thickness of the epithelium, ETM = thickness of the muscular tunica, MCC = 

average of goblet cells per villus intestinal, area and changes in the liver and gonads (Yilmaz, 

Genc & Genc 2007; Mello et al, 2012; Mello et al, 2013; Salwa et al, 2013; Lima, 2014; 

Santos et al, 2015; Maftuch et al, 2018; Abdel-Azizet al, 2020; Dawood et al, 2020), thickness 

of the gastro-intestinal mucosa layer (Rodrigues, Saturnino & Fernades 2017; Nimet, Amorim 

& Delariva 2018) thickness of the muscle layers (Kihara, Ohba & Sakata 1995; Molina, 

Pelissari & Feirhmann 2009; Shiraishii et al, 2009), and, (ii) in the analysis of the amount of 

glycogen in the liver parenchyma (Gawish Saa-Eda, Omar & Sarhan 2013). The data should 

always be compared with control groups (standard), in order to establish improvements in the 

morphophysiological and nutritional conditions that allow the highest quality and quantity in 

zootechnical performance in animal husbandry (Fornel & Cordeiro-Estrela 2012; Salman & 

Giachetto 2014). 

 

3. Use Of Imagej and Histomorphometric Analysis 

 

According Barbosa, Silva & Mendes (2014), ImageJ is a free Java Software developed 

by Wayne Rasband at the National Institute of Health (Bethesda, MD, USA), that has been 

applied to histological analysis (Egan et al, 2012). It has a simple and practical interface on its 

toolbar (Figure 1) and through plug-ins it allows users to employ various types of metric 

analysis, such as frequency distribution, distances, areas, perimeters, circumferences, counts, 

and angles (Zur & Klement 2015).  

Note in Figure 1 that the commands are highlighted with red letters, and each one has a 

role during the PDI and the measurements that will be performed by the software. For each 
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click, there is a step to be taken for the inclusion of the image, its duplication, calibration, 

exposure of the image size bar, equalization, segmentation and specific measurements. 

commands for the PDI are shown: ImageJ graphical interface (letters in red - a - command 

bar, b - toolbar, c - status bar, d - progress bar. 

 

Figure 1. After the first step opening ImageJ, the window below will open, and the initial.  

 

Source: Authors. 

 

Morphological analysis and tissue changes in animals have been carried out through 

histomicrographs, which are acquired by capturing images of histological slides via cameras 

coupled to optical microscopes (Novaes et al, 2007; Silva et al, 2016; Moawad et al, 2017). 

The digital processing of histomicrograph technique needs a software, such as the 

ImageJ, whose images are captured from an optical microscope with attached cameras 

(Novaes et al, 2007; Ferreira & Rasband 2012; Venter & Niesler 2019). There is a wide range 

of features and applicability of ImageJ and its Plugins, for PDI and morphometric studies. 

ImageJ is in the public domain, free of charge, for consolidated use by the scientific 

community, mainly for histological structures (Papadopulos et al, 2007; Venter & Niesler 

2019). 

ImageJ enables descriptive and quantitative measurements with confidence and greater 

accuracy, as the researchers’ observations concerning measurements can vary due to personal 

factors (Oliveira et al, 2010). The use of ImageJ software in histomorphometry goes beyond 

the simple fact of measuring, ensuring that data and measurements are correct and constant 

among observers (Oliveira et al, 2010, Zur & Klement 2015). In qualitative and quantitative 

research approaches, it is important to consider the possibility of measurements subjectivity, 

which would be understood as an analytical-explanatory systemic concern of the real (Majeed 

et al, 2019). 

The ImageJ Software provides several resources and complementary tools that support 

the analysis of histomicrography. It is possible to use the selection tools and colors adjustment 
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according to histochemical staining, manual and automated measurements, image scales, 

segmentation, and filters (Burger & Burge 2008). There are add-ons of native resources in 

ImageJ, such as macros and specific auxiliary plug-ins for morphometric studies (Ferreira & 

Rasband, 2012). 

 

4. Methodology for Computational Histomorphometry Using ImageJ 

 

The application of histomorphometry using ImageJ was performed with a histological 

slide fragment of fish intestine (Teleostei: Characidae – Astyanax altiparanae Garutti & 

Britski, 2000), placed in the animal pathology laboratory collection of Catholic University 

Dom Bosco (UCDB). The slide was stained with PAS (Periodic Acid-Schiff) and observed by 

a light microscope under the 10x lens. The microphotography PDI was initiated by opening 

(Open) the file command on the ImageJ toolbar (File) (Figure 2). 

 

 

Figure 2. In this step, the image was opened from the stored archive on the device and the 

indicated command was used: Open file command of the histomicrography of the lambari (A. 

altiparanae) intestine.  

 

Source: Authors. 
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In the previous step, in the beginning of the works, the image to be studied was inserted. 

From the file on the device, this command indicating (open) in the figure allow opening in the 

format that the illustration is saved. 

After opening, the image was duplicated using the command image and duplicate, in 

order to avoid changes in the original image that goes through the PDI (Figure 3). 

 

Figure 3. Duplication of the image of lambari (A. altiparanae) intestine slide, using the 

command Image and Duplicate. 

 

Source: Authors. 

 

The original opened image is digitally processed and can be modified and saved in 

another format (from JPGE to TIFF). In the previous step, it is suggested to duplicate the 

image, so it retains the original characteristics of the image. 

Subsequently, the images must be calibrated, that is, establish a known metric reference 

in order to position a metric object or instrument providing a comparison with other areas of 

tissues, cells, and substances, regardless of material (Russ 2015; Noronha, de Medeiros & 

Pereira 2018). The Straight command is used to draw a line at the bottom of the image and 

define the metric units to be worked on, according to the needs of the investigation (Analyze -

> Set Scale). In the opened window, insert the magnification value of the image in the known 

distance option (Known Distance). Next to the Unit of length, type the unit of measurement 
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(um = µm), select Global, and then, Ok. (Figure 4).  

 

Figure 4. Calibration of image the lambari (A. altiparanae) histomicrograph, using the 

following commands: Analyze and Set Scale. Demote the image according to its original size 

during capture under the microscope, ensuring the accuracy of the measurements.  

 

Source: Authors. 

 

In the previous step, the calibration is relevant. From there, all measurements take as 

reference the size of the image informed by the user, and the results appear with the units in 

line. The size inserted during this calibration comes from the magnification of the image in 

the microscope in which it was photographed and depends on the amplitude of the lenses and 

objectives. Once calibrated, the scale (Scale Bar) is added to the image obtained during the 

magnification and visualization under the microscope (Figure 5).  

At this moment, the scales must be inserted in the original figure, so that the viewer 

can have notion of dimension. Observe the bar and the unit number within the figure, which 

takes part of the image to be measured. 

The height and thickness measurements (Length Measurements) of the image tissues are 

performed using the Straight subcommand, click on the image with the left mouse and cross 

the two ends of the extension to be measured (Figure 6). 

In the previous figure the yellow lines represent the measurements made. Note that each 

of them receives a calibration number and the corresponding values in the table. During the 

measurements of histological structures, the next measurement should be started, maintaining 
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a pattern of proximity to the point chosen for the beginning and end, taking as reference the 

previous point. 

 

Figure 5. Scale bar insertion in the image of the lambari (A. altiparanae) intestine slide. The 

image size scale must be introduced using the indicated commands: Analyze. 

 

Source: Authors. 
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Figure 6. Steps to measure the height of intestinal villi of lambari (A. altiparanae). Start 

clicking in the Length measurements command, then Straight subcommand and create the 

measurement lines (in yellow) by crossing the two ends of the extension of the structure to be 

measured. 

 

Source: Authors. 

 

Each measurement can be automatically numbered and shown in a dialog box (ROI 

Manager) (Figure 6). In that same window click on Measure to measure the selected regions, 

which will be shown in a new result window in Length, being able to save each step. Note 

that the first marked measurement corresponds to the “magnification bar” and should be 

discarded as data for analysis. To measure the total area of histomicrography, the simple 

method using ImageJ is used. Initially, the duplicated image (Image -> Duplicate) (Figure 3) 

and the image area to be measured is selected, proceed with its binarization/manual 

segmentation by the commands/subcommand in the ImageJ toolbar (Image -> Adjust-> color 

Threshold) for image color equalization (Figure 7). Binarization is used to segment the 

images with different colors, aiming to separate different areas. 
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Figure 7. Commands for processing the equalization (binarization/segmentation) of the 

lambari (A. altiparanae) intestine histomicrograph: Image -> Adjust-> color Threshold. 

 

Source: Authors. 

 

Area measurements are always preceded by preparation, so that different regions can be 

distinguished. In the previous figure, note the Threshold command, which allows image 

equalization or binarization. 

After opening the color threshold window, the graphics can be adjusted to the necessary 

tones to form two distinct areas 1 and 2, one of this is prepared to be measured (Figure 8). 
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Figure 8. Image segmentation using Threshold command for - 1: measured portion – villous 

area; 2: light area of the lambari (A. altiparanae) intestine histomicrograph. The red layer is 

the area to be measured. 

 

Source: Authors. 

 

The binarization or equalization allowed to separate (fragment) the previous image into 

two distinct regions, as indicated (1 and 2), that is, a light and a dark (white and red). See in 

the figure that the red portion corresponds to the chosen area to be measured. 

The equalization procedure permits to select the region of the object (Image) of interest 

for measurement (Figure 8) (Li & Plataniotis, 2014). The measurements can be calculated 

using the Analyze -> Measure function (Figure 8), which in this example was applied to the 

height of the intestinal villus of the lambari (A. altiparanae). 

The stains used in slides submitted to histochemical treatments are read according to 

their colors (pixels), and it is possible to segment them according to the types of tissues and or 

cells, clusters of biomolecules in the respective layers. The characteristics of 

histomicrography are stained by histochemical processes that enable to easily measure each 

tissue area separately. For this, through the Thresholding Tool, it is possible to segment the 

image and separate each tissue area to measure the desired measures. This function 

categorizes in pixels the different tissue intensities, continuous or discontinuous cells or 

molecules, by calorimetric selection and amount of gray, and through Brightness, the amount 

of different tones of the image and the Smooth Tool overlap the pixels. 
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There are histochemical methods for staining cell structures (organelles and cells) and 

biomolecules that serve as a parameter for assessing normal or altered tissues, functioning as 

a marker of interest (Laplante, 2018). The most practical way to use and apply ImageJ and the 

counting functions can be found using the Multi-Point Toolbar command with the click of a 

mouse, mark what you want to count.  Goblet cells were individually marked and counted, 

displayed by yellow points with numbers that correspond to the quantity of cells (Figure 9). 

 

Figure 9. Counting function of goblet cells in histomicrography of the lambari (A. 

altiparanae) intestine. Note the yellow points that represent each goblet cell individually 

marked using mult-point bar. Each mark has a number and the last one corresponds to the 

total quantity of cells. 

 

Source: Authors. 

 

The marked areas in the figure correspond to the counted units. In this way, the amount 

of any particle in the tissues can be measured. Using the same histomicrograph as an example, 

other measurements can be made using ImageJ, such as the thickness of villi, epithelia, brush 

edges and muscle tunics, among others.  
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5. Final Considerations  

 

The use of Image J software has applications in the most diverse areas, biological, 

agronomic and medicine (human and veterinary). Many studies can be performed with a focus 

on morphometry, allowing qualitative and quantitative measurements to be made from living 

tissues and microorganisms. For future work, molecular, cellular, tissue and organ 

measurements of the most varied species are suggested. Interpretations of images with Image 

J, can assist in the search for nutritional efficacy, medications and also in tissue injuries 

(pathologies).   

The use of ImageJ has proved to be a complementary resource to assess tissue 

morphology and can be applied in several models, providing the use of safe tools for image 

analysis and monitoring, especially the performance of appropriate management in animal 

husbandry, contributing to environmental health and efficiency in animal production.  

 

Acknowledgments 

 

To the Coordination for the Improvement of Higher Education Personnel (CAPES) for 

providing doctoral scholarships Postgraduate Support Program for Private Education 

Institutions (PROSUP/CAPES)  and process NOPROSUP/CAPES 149152/2017-00, to the 

Catholic University Dom Bosco (UCDB) for their support in carrying out this research and to 

the Federal Institute of Mato Grosso, the Dean of Research, Graduate Studies and Innovation 

(PROPES) and Mato Grosso do Sul (IFMT and IFMS) for the removal of employees and 

incentives.  

 

References 

 

Abdel-Aziz, M., Bessat, M., Fadel, A., & Elblehi, S. (2020). Responses of dietary 

supplementation of probiotic effective microorganisms (EMs) in Oreochromis niloticus on 

growth, hematological, intestinal histopathological, and antiparasitic activities. Aquaculture 

International, 28(1), 1-17. doi: 10.1007/s10499-019-00505-z 

 



Research, Society and Development, v. 9, n. 11, e1459119586, 2020 

(CC BY 4.0) | ISSN 2525-3409 | DOI: http://dx.doi.org/10.33448/rsd-v9i11.9586 

16 

Barbosa, D. H. B. M., Silva, A. C., & Mendes, M. V. A. (2014). Caracterização 

Granulométrica e Automação do Método de Gaudin & Através do ImageJ. Enciclopédia 

Biosfera - Centro Científico Conhecer, 10(19): 166–176. Available in: https://bit.ly/2Yfp2Ro 

 

Burger, W. & Burge, M. J. (2008). Digital Image Processing - An Algorithmic Approach 

using Java. Springer-Verlag, New York (USA).  

 

Caicedo, J. C., Cooper, S., Heigwer, F., Warchal, S., Qiu, P, Molnar, C., & Wawer, M. 

(2017). Data-analysis strategies for image-based cell profiling. Nature methods, 14(9), 849-

863. doi: 10.1038/nmeth.4397 

 

Carson, F. L., & Hladik, C. (2009). Histotechnology: a self-instructional text. (3rd ed.), 

Chicago: ASCP Press.  

 

Casero, R., Siedlecka, U., Jones, E. S., Gruscheski, L., Gibb, M., Schneider, J. E., & Grau, V. 

(2017). Transformation diffusion reconstruction of three-dimensional histology volumes from 

two-dimensional image stacks. Medical image analysis, 38, 184-204. doi: 

10.1016/j.media.2017.03.004 

 

Dawood, M. A., Eweedah, N. M., Khalafalla, M. M., Khalid, A., El Asely, A., Fadl, S. E, & 

Ahmed, H. A. (2020). Saccharomyces cerevisiae increases the acceptability of Nile tilapia 

(Oreochromis niloticus) to date palm seed meal. Aquaculture Reports, 17, 100314. doi: 

10.1016/j.aqrep.2020.100314 

 

De Laffitte Alves, M. V. S., Bordão, D. M., de Moura Gonçalves, A. B., & da Costa, F. F. 

(2018). A utilização do software ImageJ no processamento de imagens tomográficas. Revista 

Saber Digital, 11(2), 50-59. Available in: https://bit.ly/30hIX2p 

 

Di Ieva, A., Bruner, E., Widhalm, G., Minchev, G., Tschabitscher, M., & Grizzi, F. (2012). 

Computer-assisted and fractal-based morphometric assessment of microvascularity in 

histological specimens of gliomas. Scientific Reports, 2, 429. doi: 10.1038/srep00429 

 

https://bit.ly/2Yfp2Ro
https://bit.ly/30hIX2p


Research, Society and Development, v. 9, n. 11, e1459119586, 2020 

(CC BY 4.0) | ISSN 2525-3409 | DOI: http://dx.doi.org/10.33448/rsd-v9i11.9586 

17 

Dias, F. C. (2008). Uso do Software ImageJ para a análise quantitativa de imagens de 

microestrutura de materiais. Dissertação de Mestrado, Instituto Nacional de Pesquisas 

Espaciais, São José dos campos, SP, Brasil.  

 

Eberhardt, T. D., Lima, S. B. S. D., Lopes, L. F. D., Borges, E. D. L., Weiller, T. H, & 

Fonseca, G. G. P. D. (2016). Measurement of the area of venous ulcers using two software 

programs. Revista latino-americana de enfermagem, 24. doi: 10. 1590/1518-8345 .1673.2862 

 

Egan, K. P, Brennan, T. A. & Pignolo, R. (2012).  Bone Histomorphometry using free and 

commonly available software. Histopathology, 61(6), 1168-1173. doi: 10.1111/j.1365-

2559.2012. 04333.x 

 

Ferreira, T., & Rasband, W. S. (2012). ImageJ User Guide. IJ 1(46). Retrieved from 

https://bit.ly/2S7cw2g 

 

Fornel, R. & Cordeiro-Estrela, P. (2012). Morfometria geométrica e a quantificação da forma 

dos organismos. Temas em Biologia, 20, 101-120. doi: 10.13140/2.1.1793.1844 

 

Gawish Saa-Eda, N., Omar, N. M. & Sarhan, N. M. R. (2013). Protective Effect of Omega-3 

Fatty Acids on 5-fluorouracil-induced Small Intestinal Damage in Rats: Histological and 

Histomorphometric Study. Trends in Medical Research 8, 36–62. doi: 

10.3923/tmr.2013.36.62 

 

Ginel, P. J., Lucena, R., Rodriguez, J. C. & Ortega, J. (2002). Avaliação citológica 

semiquantitativa de amostras normais e patológicas do canal auditivo externo de cães e gatos. 

Veterinary Dermatology, 13(3), 151–156. doi: 10.1046/j.1365-3164.2002.00288.x 

 

Gonzalez, R. C. & Woods, R. C. (2010). Digital Image Processing. Prentice Hall. (3a. ed.), 

Upper Saddle River: Pearson.  

 

Grune, T., Kehm, R., Höhn, A., & Jung, T. (2018). “Cyt/Nuc,” a Customizable and 

Documenting ImageJ Macro for Evaluation of Protein Distributions Between Cytosol and 

Nucleus. Biotechnology Journal, 13(5), 1700652. doi: 10. 1002/biot.201700652 

 

https://bit.ly/2S7cw2g


Research, Society and Development, v. 9, n. 11, e1459119586, 2020 

(CC BY 4.0) | ISSN 2525-3409 | DOI: http://dx.doi.org/10.33448/rsd-v9i11.9586 

18 

Guo, G. & Zhang, N. (2019). A survey on deep learning-based face recognition. Computer 

Vision and Image Understanding, 189, 102805. doi: 10.1016/j.cviu.2019.102805 

 

Hannickel, A., Silva, M., Barros, H., & Albuquerque, M. (2002). Image J como ferramenta 

para medida da área de partículas de magnetita em três escalas nanométricas. CIT, 4, 16-26. 

Available in: https://bit.ly/30cXrjW 

 

Jatobá, A., Moraes, K. N., Rodrigues, E. F., Vieira, L. M., & Pereira, M. O. (2018). 

Frequency in the supply of Lactobacillus influence its probiotic effect for yellow tail 

lambari. Ciência Rural, 48(10). doi: 10.1590/0103-8478cr20180042  

 

Jeffcoate, W. J., Musgrove, A. J. & Lincoln, N. B. (2017). Using image J to documenthealing 

in ulcers of the foot in diabetes. International Wound Journal, 14(6), 1137-1139. doi: 

10.1111/iwj.12769.  

 

Karachle, P. K. & Stergiou, K. I. (2010). Intestine morphometrics of fishes: a compilation and 

analysis of bibliographic data. Acta Ichthyologica et Piscatoria, 40(1), 45–54. doi: 

10.3750/AIP2010.40.1.06.  

 

Kihara, M., Ohba, K. & Sakata, T. (1995). Trophic effect of dietary lactosucrose on intestinal 

túnica muscularis and utilization of this sugar by gut microbes in red seabream Pagrus major, 

a marine carnivorous teleost, under artificial rearing. Comparative Biochemistryand 

Physiology, 112, 629–634. doi: 10.1016/0300-9629(95)02037-3 

 

Laplante, P. A. (2018). Encyclopedia image process. Boca raton: CRC Press. doi: 

10.1201/9781351032742 

 

Li, X. & Plataniotis, K. N. (2014). A complete color normalization approach to 

histopathology images using color cues computed from saturation-weighted statistics. IEEE 

Trans Biomed Eng, 62(7): 1862-73. doi: 10.1109/TBME.2015.2405791 

 

Lima, F. W. (2014). Colonização e morfometria intestinal de lambaris-do-rabo-amarelo 

Astyanax altiparanae alimentados com dietas contendo levedura Saccharomyces cerevisiae 



Research, Society and Development, v. 9, n. 11, e1459119586, 2020 

(CC BY 4.0) | ISSN 2525-3409 | DOI: http://dx.doi.org/10.33448/rsd-v9i11.9586 

19 

como probiótico. Dissertação de Mestrado, Universidade Federal de Viçosa, Viçosa, MG, 

Brasil.  

 

Maftuch, M., Sanoesi, E., Farichin, I., Saputra, B. A, Ramdhani, L., Hidayati, S, & Prihanto, 

A. A. (2018). Histopathology of gill, muscle, intestine, kidney, and liver on Myxobolus sp.-

infected Koi carp (Cyprinus carpio). Journal of parasitic diseases, 42(1), 137-143. doi: 

10.1007/s12639-017-0955-x 

 

Majeed, H., Keikhosravi, A., Kandel, M. E., Nguyen, T. H., Liu, Y, Kajdacsy-Balla, A., & 

Popescu, G. (2019). Quantitative histopathology of stained tissues using color spatial light 

interference microscopy (cSLIM). Scientific reports, 9, 14679. doi: 10.1038/s41598-019-

50143-x 

 

Mello, H. D, Moraes, J. R., Niza, I. G., Moraes, F. R. D., Ozório, R. O, Shimada, M. T., & 

Claudiano, G. S. (2013). Efeitos benéficos de probióticos no intestino de juvenis de Tilápia-

do-Nilo. Pesquisa Veterinária Brasileira, 33(6), 724-730. doi: 10.1590/S0100-

736X2013000600006 

 

Mello, R. O., Silva, C. M., Fonte, F. P., Silva, D. L, Pereira, J. A., Margarido, N. F., & 

Martinez, C. A. (2012). Evaluation of the number of goblet cells in crypts of the colonic 

mucosa with and without fecal transit. Revista do Colegio Brasileiro de Cirurgioes, 39(2), 

139. doi: 10.1590/S0100-69912012000200010. 

 

Meurer, F., Hayashi, C., Costa, M. M., Freccia, A. & Mauerwerk, M. T. (2007). 

Saccharomyces cerevisiae como probiótico para alevinos de tilápia do Nilo submetidos a 

desafio sanitário. Revista Brasileira de Zootecnia. 36(5), 1219-1224. doi:10.1590/S1516-

35982007000600001 

 

Moawad, U. K., Awaad, A. S., & Tawfiek, M. G. (2017). Histomorphological, histochemical, 

and ultrastructural studies on the stomach of the adult African catfish (Clarias 

gariepinus). Journal of microscopy and ultrastructure, 5(3), 155-166. doi: 

10.1016/j.jmau.2016.08.002 

 



Research, Society and Development, v. 9, n. 11, e1459119586, 2020 

(CC BY 4.0) | ISSN 2525-3409 | DOI: http://dx.doi.org/10.33448/rsd-v9i11.9586 

20 

Mojekwu, T. O. & Anumudu C. I. (2015). Advanced Techniques for Morphometric Analysis 

in Fish. Journal Aquac Res Development, 6(354), 1. doi: 10.4172/2155-9546.1000354 

 

Molina, G., Pelissari, F. M. & Feirhmann, A. C. (2009). Consequências da desnutrição 

proteica para o Trato Gastrintestinal. Arquivos do Museu Dinâmico Interdisciplinar, 13(1): 

12-24. Retrieved from https://bit.ly/2G9QXvB.  

 

Nimet, J., Amorim, J. P. A. & Delariva, R. L. (2018). Histopathological alterations in 

Astyanax bifasciatus (Teleostei: Characidae) correlated with land uses of surroundings of 

streams. Neotrop. Ichthyol, 16(1). doi: 10.1590/1982-0224-20170129. 

 

Noronha B. G. de, de Medeiros A. D. & Pereira M. D. (2018). Assessment of the 

physiological quality of Moringa oleifera Lam. Ciência Florestal, 28(1), 393-402. Doi: 

10.5902/1980509831615 

 

Novaes, A. P. de, Herrmann, P. S. P., Bernardes Filho, R. & Benetti FM. (2007). Equipment 

for coupling a digital camera to an optical microscope. In: Méndez-Vilas, A, Díaz J. (Eds.). 

Modern Research and Educational Topics in Microscopy, 989-995. São Carlos: Embrapa. 

Retrieved from https://bityli.com/aDX0C 

 

Novaes, A. P. de, Paula, P. de, Bernardes Filho, H. J. R. & Marques, R. F. B. (2010). 

Dispositivo para Ampliação da Magnificação do Microscópio Óptico – 32º Boletim de 

Pesquisa e Desenvolvimento. São Carlos: Embrapa Instrumentação. Retrieved from 

https://bityli.com/OJXGk 

 

Oliveira, R. S. M. F. de, Oliveira, F. A. M. de & Pinheiro, H. S. (2010). Programando o 

Software ImageJ para a Seleção Automática de áreas arcadas por Imuno-Histoquímica e 

Coradas com o Cromógeno DAB e Contra-Coradas pela Hematoxilina. Revista 

Interdisciplinar de Estudos Experimentais, 2(3), 76–80. Retrieved from 

https://bit.ly/2U6Wd81  

 

Papadopulos, F., Spinelli, M., Valente, S., Foroni, L., Orrico, C., Alviano, F. & Pasquinelli, 

G. (2007). Common Tasks in Microscopic and Ultrastructural Image Analysis Using ImageJ. 

Ultrastructural Pathology, 31(6), 401-407. doi: 10.1080/01913120701719189 



Research, Society and Development, v. 9, n. 11, e1459119586, 2020 

(CC BY 4.0) | ISSN 2525-3409 | DOI: http://dx.doi.org/10.33448/rsd-v9i11.9586 

21 

 

Passoni, S., Borges, F. da S., Pires, L. F., Saab, S. da & Cooper, M. (2014). Programa "Image 

J" para estudar a distribuição de poros do solo. Ciência e Agrotecnologia, 38(2): 122-128. doi: 

10.1590/S1413-70542014000200003. 

 

Passos, M. L. V., Souza, J. B. C., Silva, E. A., Silva, C. A. A. C., Sousa, W. S. & Almeida, E. 

I. B. (2020).  Digital processing of leaf area of soybeans, subjected to different treatments of 

seeds. Scientific Electronic Archives, 13(3): 24-30. doi:10.36560/1332020835 

 

Rodrigues, D. F., Mendes, F. F., Dias, T. A., Lima, A. R. de & Silva, L. A. F. da. (2013). O 

programa ImageJ como ferramenta de análise morfométrica de feridas cutâneas. Enciclopédia 

Biosfera, 9(17). Retrieved from https://bit.ly/30cYGzC.  

 

Rodrigues, R. A., Saturnino, K. C. & Fernades C. E. (2017). Liver histology and 

histomorphometry in hybridsorubim (Pseudoplatystoma reticulatum e Pseudoplatystoma 

corruscans) reared on intensivefish farming. Aquaculture Research, 48(9), 5083–5093. doi: 

10.1111/are.13325 

 

Rotta, M. A. (2003). Aspectos gerais da fisiologia e estrutura do sistema digestivo dos peixes 

relacionados à piscicultura. Embrapa Pantanal-Documentos 53 (INFOTECA-E). Corumbá: 

Embrapa. Available in: https://bityli.com/2rz36 

 

Russ, J. C. (2015). Image Analysis of Foods. Journal of Food Science, 80(9). doi: 

10.1111/1750-3841.12987 

 

Salman, A. K. D. E. & Giachetto, P. F. (2014). Conceitos estatísticos aplicados à 

experimentação zootécnica. PUBVET. 8(12), 1416-1550. Available in: https://bit.ly/35skAkd 

 

Salwa, A. A., Gawish, D. A. N., Omar, N. M. & Sarhan, N. M. R. (2013). Protective Effect of 

Omega-3 Fatty Acids on 5-fluorouracil-induced Small Intestinal Damage in Rats: Histological 

and Histomorphometric Study. Trends in Medical Research, 8(2), 36-62. doi: 

10.3923/tmr.2013.36.62 

 



Research, Society and Development, v. 9, n. 11, e1459119586, 2020 

(CC BY 4.0) | ISSN 2525-3409 | DOI: http://dx.doi.org/10.33448/rsd-v9i11.9586 

22 

Santos, D. C. M. dos, Cupertino, M. do C., Matta, S. L. P. da, Oliveira, J. A. de & Santos, J. 

A. D. dos S. (2015). Histological alterations in liver and testis of Astyanax aff. bimaculatus 

caused by acute exposition to zinc. Revista Ceres, 62(2), 133–141. doi: 10.1590/0034-

737X201562020002 

 

Santos, F. C. G. dos & Kalid, R. de A. (2020). Technological prospecting: a study of 

technologies applied to cocoa processing and derivatives. Research, Society and 

Development, 9(3), 1-26. doi: 10.33448/rsd-v9i3.2354 

 

Schnell, M., Mittal, S., Falahkheirkhah, K, Mittal, A., Yeh, K., Kenkel, S., & Bhargava, R. 

(2020). All-digital histopathology by infrared-optical hybrid microscopy. Proceedings of the 

National Academy of Sciences, 117(7), 3388-3396. doi: 10.1073/pnas.1912400117 

 

Schindelin, J., Rueden, C. T., Hiner, M. C., & Eliceiri, K. W. (2015). The ImageJ ecosystem: 

An open platform for biomedical image analysis. Molecular reproduction and 

development, 82(7-8), 518-529. doi: 10.1002/mrd.22489 

 

Sengar, N., Dutta, M. K. & Sarkar, B. (2017). Computer vision-based technique for 

identification of fish quality after pesticide exposure. International Journal of Food 

Properties, 20(sup. 2), 2192–2206. doi: 10.1080/10942912.2017.1368553 

 

Shiraishii, C. S., Azevedo, J. F. de, Silvai, A. V. da Sant’ana, D. de M. G. & Araújo, E. J. de 

A. (2009). Análise morfométrica da parede intestinal e dinâmica de mucinas secretadas no 

íleo de frangos infectados por Toxoplasma gondii. Ciência Rural, 39(7), 2146–2153. doi: 

10.1590/S0103-84782009000700030. 

 

Silva, E. M., Sampaio, L. A., Martins, G. B., Romano, L. A., & Tesser, M. B. (2013). 

Desempenho zootécnico e custos de alimentação de juvenis de tainha submetidos à restrição 

alimentar. Pesquisa Agropecuária Brasileira, 48(8), 906-912. doi: 10.1590/S0100-

204X2013000800014 

 

Sousa, A. T. O., Vasconcelos, J. M. B. & Soares, M. J. G. O. (2012). Software Image Tool 3.0 

as an instrument for measuring wounds. Journal of Nursing, 6(10): 2569–2573. doi: 

10.5205/1981-8963-v6i10a7503p2569-2573-2012 



Research, Society and Development, v. 9, n. 11, e1459119586, 2020 

(CC BY 4.0) | ISSN 2525-3409 | DOI: http://dx.doi.org/10.33448/rsd-v9i11.9586 

23 

 

Søreide, K., Nedrebø, B. S, Reite, A., Thorsen, K., & Kørner, H. (2009). Endoscopy, 

morphology, morphometry and molecular markers: predicting cancer risk in colorectal 

adenoma. Expert review of molecular diagnostics, 9(2), 125-137. doi: 

10.1586/14737159.9.2.125 

 

Tawfiek, M., Moawad, U. & Awaad, A. (2017). Histomorphological, histochemical, and 

ultrastructural studies on the stomach of the adult African catfish (Clarias gariepinus). 

Journal of Microscopy and Ultrastructure, 5(3), 155-166. doi: 10.1016/j.jmau.2016.08.002.  

 

Valente, A.  J., Maddalena, L. A., Robb, E. L, Moradi, F. E. & Stuart, J. A. (2017). A simple 

ImageJ macro tool for analyzing mitochondrial network morphology in mammalian cell 

culture. Acta Histochemica, 119(3), 315–326. doi: 10.1016/j.acthis.20 17.03.001 

 

Venter, C. & Niesler, C. U. (2019). Rapid quantification of cellular proliferation and 

migration using ImageJ. Biotecniques, 66 (2): 99-102. doi: 10.2144/btn-2018-0132 

 

Vidal, M. R., Ruiz, T. F. R., Santos, D. D., Gardinal, M. V. B., Jesus, F. L., Faccioli, C. K., 

Vicentini, C, A. (2019). Morphological and histochemical characterisation of the mucosa of 

the digestive tract in matrinxã Brycon amazonicus (Teleostei: Characiformes). Journal of Fish 

Biology, 96(1), 251-260. doi: 10.1111/jfb.14217 

 

Wang, C. W, Ka, S. M, & Chen, A. (2014). Robust image registration of biological 

microscopic images. Scientific reports, 4, 6050. doi: 10.1038/srep06050 

 

Weber, J. F. & Santos, A. L. F. dos. (2019). Utilização do software ImageJ para avaliar área 

de lesão dermonecrótica. Revista de Saúde Digital e Tecnologias Educacionais, 4(1), 120–

130. doi: 10.36517/resdite. V.4.n1.2019.a9 

 

Yilmaz, E., Genc, M. A. & Genc, E. (2007). Effects dietary mannan oligosacharides on 

growth, body. Israeli Journal of Aquaculture-Bamidgeh, 59, 182–188. doi: 10.1111/are.12801 

 



Research, Society and Development, v. 9, n. 11, e1459119586, 2020 

(CC BY 4.0) | ISSN 2525-3409 | DOI: http://dx.doi.org/10.33448/rsd-v9i11.9586 

24 

Zur, G. & Klement, E. (2015). Use of ImageJ software for histomorphometric evaluation of 

normal and severely affected canine ear canals. Canadian Jounal Veterinaria Research, 

79(4), 316–322. Retrieved from https://bit.ly/3kVE2w 

 

 

Percentage of contribution of each author in the manuscript 

Lucimar Rodrigues Vieira Curvo – 45% 

Milena Wolff Ferreira – 10% 

Celso Sorares Costa – 10% 

Guilherme Ribeiro Capibaribe Barbosa – 10% 

Sandra Adriana Uhry – 5% 

Ulisses Simon da Silveira – 5% 

Alanderson Rodrigues da Silva – 5% 

Gisele Braziliano de Andrade – 10% 

 

about:blank
https://bit.ly/3kVE2w

